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About data access pages
A data access page is a special type of Web page that enables you to
view and work with data from a database. It might also include data from
other sources, such as Microsoft Excel. How you interact with the page
depends on what it's used for.
Interactive reporting
Data analysis
Data access pages are supported in Microsoft Internet Explorer 5.01 with
Service Pack 2 (SP2) or later.

Parts of a data access page
A data access page can have many features; however, these features
vary depending on the purpose of the page. Some of the most common
features are listed below. (Fields and records are always part of a data
access page; however, how they are presented varies.)

Expand indicator
Group header
A record is a collection of related facts about one entity, such as a
customer, a customer order, or an employee, stored in a database.
A text box displays existing data from the underlying database, or, if
allowed, accepts new data that you enter to be stored in the database.
Group records for 04-Mar.
The record navigation toolbar lets you quickly move between records or
add, delete, save, undo changes to, sort, or filter records.
Groups organize data into sets. For example, the above page groups
records of customers' orders by date. The name of each date is the
group header. Depending on how the page was designed, either all the
groups are displayed on the page (usually with their records hidden), or

no specific group is displayed until you choose one from a list of available
groups. If the page shows all groups, you can display the records for a
specific group by clicking its expand indicator. Some or all groups in the
page may support data entry.
In a grouped data access page, each group might have its own record
navigation toolbar located at the bottom of the expanded group.
In addition to the above, a page might contain one or more of the
following:
PivotTable lists
Spreadsheets
Charts
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Work with data on a data access page
Add, edit, and delete data
Save or undo changes
Navigate between fields and records
Sort, find, filter, or refresh data
Use shortcut keys on a data access page
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calculated field
A field, defined in a query, that displays the result of an expression
rather than displaying stored data. The value is recalculated each
time a value in the expression changes.
chart
A graphical view of database data that is used to visually display
trends, patterns, and comparisons. When the data in the database
changes, the chart updates accordingly. If the chart is linked to a
PivotTable list or spreadsheet on the data access page, the chart
changes when you change the data in the PivotTable list or
spreadsheet. A chart includes its own toolbar and built-in Help.
D
Back to top
data access page
A Web page that has a connection to a database. By using a data
access page, you can view, add, edit, and manipulate data stored in
the database. A data access page can also include data from other
sources, such as Microsoft Excel.
database
A collection of data related to a particular subject or purpose. A data
access page can connect to a Microsoft Access database or a
Microsoft SQL Server database.
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expand indicator
A button that is used to expand or collapse groups of records on a
data access page; it displays the plus (+) or minus (-) sign.
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filter
A set of criteria that is applied to data to show a subset of the data.
In a data access page, you can filter records by using the Filter By
Selection command. Note: A data access page can also have a builtin filter. On this type of page, you don't see any records until you
choose a value from a list on the page. Only records that contain the
value you choose will be displayed in the page until you choose
another value to filter on.
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GIF
A graphics file format (.gif extension in Microsoft Windows) used to
display indexed-color graphics on the World Wide Web. It supports
up to 256 colors and uses lossless compression, meaning that no
image data is lost when the file is compressed.
group
A collection of objects that behave as one for the purpose of moving,
resizing, or rotating them. A group can be composed of multiple sets
of groups.
group level
The depth at which a group in a report or data access page is nested
inside other groups. Groups are nested when a set of records is
grouped by more than one field, expression, or group record source.
grouped data access page

A data access page that uses two or more group levels to create a
hierarchy that groups records from general categories to specific
details.
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HTML
The standard markup language used for documents on the World
Wide Web. HTML uses tags to indicate how Web browsers should
display page elements such as text and graphics and how to
respond to user actions.
HTML extensions
A feature or setting that is an extension to the formal HTML
specification. Extensions may not be supported by all Web browsers,
but they may be used widely by Web authors. An example of an
extension is marquee scrolling text.
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JPEG
A graphics file format (.jpg extension in Windows) supported by
many Web browsers that was developed for compressing and
storing photographic images.
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Microsoft Access database
A collection of data and objects, such as tables, queries, or forms,
related to a particular topic or purpose. The Microsoft Jet database
engine manages the data.
Microsoft Office Web Components
Interactive components, such as spreadsheets, charts, and

PivotTable lists on Web pages that facilitate data analysis. To use
these components, you must have an Office 2003 license.
Microsoft SQL Server database
A database in Microsoft SQL Server that consists of tables, views,
indexes, stored procedures, functions, and triggers.
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path
The route the operating system uses to locate a folder or file; for
example, c:\House finances\March.doc.
PivotTable list
Similar to a Microsoft Excel PivotTable report, a PivotTable list
displays data in a row and column format. A PivotTable list provides
interactive capabilities in Microsoft Internet Explorer, enabling you to
reorganize the data by moving rows to columns and columns to
rows, displaying totals at the intersection of rows and columns, and
otherwise rearranging and summarizing the data to analyze it in
different ways. A PivotTable list includes its own toolbar and built-in
Help.
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record navigation toolbar
A toolbar that contains buttons for adding, deleting, saving, undoing
changes to, sorting, filtering, and moving between records, and
getting Help. In a grouped data access page, each group may have
its own record navigation toolbar that's located at the bottom of the
expanded group.
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spreadsheet
A feature on a data access page that is similar to a Microsoft Excel
worksheet. Using a spreadsheet, you can enter raw data, add
formulas, apply filters, and perform additional spreadsheet
operations. A spreadsheet includes its own toolbar and built-in Help.
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Uniform Resource Locator (URL)
An address to an object, document, page, or other destination (for
example, a newsgroup or a World Wide Web page) on the Internet
or an intranet. A URL expresses the protocol (such as FTP or HTTP)
to be accessed and where the destination is located. A URL may
also specify an Internet e-mail address. Some examples of URLs
are: http://www.someones.homepage/default.html,
ftp://ftp.server.somewhere/ftp.file, news:alt.hypertext
Universal Naming Convention (UNC)
A naming convention for files that provides a machine-independent
means of locating the file. A UNC name will usually include a
reference to a shared folder and file accessible over a network rather
than a folder and file that's specified by a drive letter and path. For
example, the UNC name for a database named Northwind.mdb on a
shared directory named Samples on a computer called
MyWorkstation would be \\MyWorkstation\Samples\Northwind.mdb.
The UNC is particularly useful in Web-based applications because it
allows you to reference data that is not necessarily stored on a
particular Web server.

Get Help on using a data access page
This topic explains how to view and work with a data access page in
general; however, the designers of the data access page that you are
viewing might have provided Help information specific to that page. For
example, they might have added instructions directly to the page, or they
might have added a custom Help button or a hyperlink to information
about the page.
A data access page may also include features that have their own built-in
help. For example, the Microsoft Office PivotTable Component,
Spreadsheet Component, and Chart Component have their own help,
which explains how to work with just that feature of the page.
To get help about using Microsoft Internet Explorer, click Contents and
Index on the Internet Explorer Help menu.
To get help for a PivotTable list, spreadsheet, or chart, click Help
that component's toolbar.
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To redisplay Microsoft Access Help, close the Help window for the
PivotTable list, spreadsheet, or chart, and then click Help
on the data
access page record navigation toolbar.
Note Other features, such as Windows Media Player, also have their
own Help, which is available by right-clicking that feature.

Get Help on Microsoft Office Web Components
To get help for the PivotTable Component, Spreadsheet Component, or
Chart Component, click Help
on the toolbar in the PivotTable list,
spreadsheet, or chart.

About Microsoft Office Web Components
Microsoft Office Web Components is a set of ActiveX controls installed
with Microsoft Office 2003. With Office Web Components installed on
your computer, you can interactively use a spreadsheet, a PivotTable list,
and a chart on a Web page in Microsoft Internet Explorer 5.01 with
Service Pack 2 (SP2) or later.
If Office Web Components is not installed on your computer but you have
an Office 2003 site license that permits intranet distribution, you can
configure the components so that users will be prompted to download
Office Web Components from your corporate intranet. This allows users
at your site to use a data access page without having Office 2003
software installed on their computers.
For information about how to configure Office Web Components, see the
Microsoft Office 2003 Resource Kit.

About View-only mode for Office Web Components
If you do not have a Microsoft Office 2003 software license installed on
your computer or accessed via a Microsoft Office 2003 application, you
can view a Microsoft Office Web Component— a Spreadsheet
Component, Chart Component, or PivotTable Component— on a Web
page, but you cannot interact with it.
To be able to interact with and use full functionality of the component you
are viewing, you must install Microsoft Office 2003 or have access to an
Office 2003 license. If you are in a corporate or group environment,
check with your network administrator for assistance.
When you are in View-only mode, you can:
View data.
Print.
Select and scroll.
Use hyperlinks.
Resize a component.
Select sheets in the Spreadsheet Component.
Expand or collapse members in a PivotTable list.
Refresh data in a PivotTable list.
Use the About, Help, and Refresh commands. Help topics that deal with
interactivity (such as formatting cells, dragging fields, sorting, filtering,
and so on) do not apply.
All commands except About, Help, and Refresh are unavailable in Viewonly mode.

Use shortcut keys on a data access page
To use the following keys, press the TAB key repeatedly until the expand
indicator or record navigation toolbar has focus. If a PivotTable list,
spreadsheet, or chart currently has focus, press CTRL+TAB.
Press
SPACE or
ENTER
LEFT ARROW
or RIGHT
ARROW
SPACE or
ENTER

To
Expand or collapse a group of records that correspond
to the expand indicator in a grouped data access page
Select a button on the record navigation toolbar

Activate the selected button on the record navigation
toolbar
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About hyperlinks
A hyperlink is a pointer from one object to another. The destination is
frequently another Web page, but it can also be a picture, an e-mail
address, a file (such as a multimedia file or Microsoft Office document),
or a program. The hyperlink itself can be displayed as text or as a picture.
You can use hyperlinks to do the following:
Navigate to a file or Web page on a network, an intranet, or the Internet
Send an e-mail message
Start a file transfer, such as a download or an FTP process
When you point to text or a picture that contains a hyperlink, the pointer
becomes a hand , indicating that it is something you can click. When a
site visitor clicks the hyperlink, the destination is displayed, opened, or
run, depending on the type of destination. For example, a hyperlink to a
sound file opens the file in a media player, and a hyperlink to a Web page
displays the page in a Web browser.
Parts of a hyperlink address
Hyperlink subaddress syntax
Examples of hyperlink addresses
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Enter a hyperlink address
Paste a hyperlink or hyperlink address
Drag an Internet shortcut
Type a hyperlink address

Follow a hyperlink
Point to the hyperlink. Click the hyperlink when the pointer changes to a
hand .
By default, a hyperlink that you haven't clicked is blue and underlined,
and a hyperlink that you have clicked is purple and underlined.
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Find specific data using a filter
By using a filter, you can find records based on whether they contain a
specific value in a particular field. For example, you can find all records
that have "Germany" in the Country field. When you apply the filter, only
the records that contain the value you selected will appear in the data
access page. Once you remove the filter, all the records will be displayed
again. For grouped data access pages, you can filter the list of groups
(the group headings) or the records within groups.
1. Do one of the following:
In an ungrouped page
In a grouped page
2. To further narrow the subset of records, continue selecting fields
and clicking Filter By Selection
until you have just the
records you want.
For example, if you want to see records only for customers in
Germany with a required date of 5/12/98, select "Germany" in
the Country field, click Filter By Selection, select "5/12/98" in
the Required Date field, and then click Filter By Selection
again.
Notes
If you select only part of the value in a field, the data access page still
uses the entire field value for filtering.
You can remove the filter and then reapply it during the same working
session.
If you browse to another data access page, you'll lose the filter.
This procedure doesn't apply to a PivotTable list, spreadsheet, or chart.
These features can be filtered independently from the rest of the data on
the data access page and may also support additional filtering
capabilities. For more information, click Help
on that component's
toolbar.

Remove a filter to show all records
Click Filter Toggle

on the record navigation toolbar.

Notes
Removing a filter doesn't delete it. However, if you close or refresh the
page, or move away from the current set of records, you will lose the
filters on a page.
This procedure doesn't apply to a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component. These
features can be filtered independently from the rest of the data on the
data access page, and may also support additional filtering capabilities.
To display help for a PivotTable list, spreadsheet, or chart, click Help
on its toolbar.

Sort data on a data access page
You can sort data on a data access page, including data that's grouped.
For grouped data access pages, you can sort the list of groups or the
records within a group.
1. Do one of the following:
In an ungrouped page, click the field you want to use for sorting
records.
In a grouped page, expand the group that you want to sort, and
then click the field you want to sort records on.
Note When you sort records within a group, the sort order only
applies to that group. It does not affect the order of records in
other groups. For example, say a data access page is grouped
by region, the region names are listed in ascending order, and
under each region employees are listed in ascending order by
their last name. If you display employee records for Mexico and
then sort employees in descending order by last name, then the
employee records for other regions will still be sorted in
ascending order, as will the list of regions themselves.
2. Do one of the following:
To sort in ascending order, click Sort Ascending
To sort in descending order, click Sort Descending

.
.

Notes
If the records are displayed in tabular format, simply click the label of the
field you want to sort records on. The records will display in ascending
order. To sort records in descending order, click the label again.
If you browse to another data access page and come back to this page,
you'll lose the sort order.
The order in which numbers, text, and special characters are sorted
depends on the database and your regional settings in Microsoft
Windows Control Panel.
This procedure doesn't apply to a Microsoft Office PivotTable

Component, Spreadsheet Component, or Chart Component. These
features can be sorted independently from the rest of the data on the
data access page, and may also support additional sorting capabilities.
To display help for a PivotTable list, spreadsheet, or chart, click Help
on its toolbar.

Apply an existing filter to a data access page
You can reapply filters that you created earlier in the current working
session. However, if you browse to another data access page after
creating the filters, or if you navigate away from the records that are
currently displayed, the filters will be lost.
On an ungrouped page, click Filter Toggle
toolbar.

on the record navigation

On a grouped page, expand the group that you want to filter, and then
click Filter Toggle
on the record navigation toolbar for that group.
Note This procedure doesn't apply to a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component. These
features can be filtered independently from the rest of the data on the
data access page, and may also support additional filtering capabilities.
To display help for a PivotTable list, spreadsheet, or chart, click Help
on its toolbar.

Make a data access page available offline
1. On the Favorites menu, click Add to Favorites.
2. In the Add Favorite dialog box, select Make available offline.
Note If the Make available offline check box is unavailable,
you won't be able to take a data access page offline. Contact
the designer of the page for assistance.
3. Click OK.
The page and associated data are saved to your computer.

Switch between offline and online modes of a page
1. Open a data access page in Microsoft Internet Explorer 5.01
with Service Pack 2 (SP2) or later.
2. On the File menu, click Work Offline.
If Work Offline is selected, the page is offline. If it is not
selected, the page is online.
Note A page will be offline if your computer is not connected to a
network when you open the page.

Synchronize an offline data access page with source data
1. On the Tools menu, click Synchronize.
2. In the Items to Synchronize dialog box, select the check box
for the data access page you want to synchronize.
3. Click Synchronize.
The Microsoft Synchronization Manger merges the offline changes with
the data in the source database.
Note The rules for merging offline data with the source database are
defined either by the designer of the page or the database administrator.
Contact them if you encounter errors or conflicts during the
synchronization process. You might lose some of your changes during
the merge operation, depending on how the rules are defined.

Make an offline data access page online
1. On the File menu, click Work Offline so that it is no longer
selected.
2. On the Favorites menu, right-click the entry for the data access
page, and then click Make available offline so that it is no
longer selected.
3. In the Confirm Offline Item Delete dialog box, click Yes.

Add a record
1. On the record navigation toolbar, click New

.

Note If you don't see the New button, it means one of the
following:
The page does not support data entry.
The designer of the page has customized the button. Look for
custom instructions on how to use the page, or contact the
designer.
2. Type the data you want in the first field, and then press TAB to
go to the next field.
3. When you are finished adding data to each field, save the
record.
Note If you make a typing mistake, press BACKSPACE. To cancel your
changes in the current field, press ESC. To cancel your changes to the
entire record, click Undo
on the record navigation toolbar.

Edit data in a record
1. Click in the field you want to edit.
Note You cannot edit calculated fields and fields that are being
used to group data. If you can't insert the input cursor inside any
of the fields in the page, the page does not support edits.
2. Type the text you want to insert.
3. Save the record.
Note If you make a typing mistake, press BACKSPACE. To cancel your
changes in the current field, press ESC. To cancel your changes to the
entire record, click Undo
on the record navigation toolbar.

Display the most current data
If other users are entering data at the same time as you are, your data
access page may not be displaying the most recent changes to the
database. To see current data, refresh the page periodically.
Click Refresh

on the Microsoft Internet Explorer toolbar or press F5.

Caution If you click Refresh before you have saved your changes,
Internet Explorer warns you that your changes may be discarded. You
must click Cancel to prevent losing your changes to the current record.
Notes
If reloading the data takes a long time and you want to cancel the
operation, click Stop
on the Internet Explorer toolbar or press ESC.
Your data access page might have a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component, which have
their own methods of selection. To display help for the PivotTable list,
spreadsheet, or chart, click Help
on its toolbar.

Save a record
On the record navigation toolbar, click Save

.

Note If you don't see the Save button, it means one of the following:
The designer of the page has customized the button. Look for custom
instructions on the page on how to save your changes.
The page is read-only and does not support additions or edits.

Show or hide records for a group
1. Scroll to the group for which you want to show or hide detail
records.
2. Do one of the following:
If the detail records are not visible, click Expand
group heading.
If the detail records are visible, click Collapse
group heading.

next to the

next to the

Note The Expand and Collapse buttons might look different on your
page.
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Select fields and records
Using the mouse
Using the keyboard
Note Your data access page might have a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component, which have
their own methods of selection. To display Help for one of these
components, click Help
on its toolbar.

Undo changes when adding or editing records
To undo changes to the current record, click Undo
navigation toolbar.

on the record

Note If you don't see the Undo button, it means one of the following:
The designer of the page has customized the button. Look for custom
instructions on the page on how to undo your changes.
The page is read-only and does not support additions or edits.

Move between records
Use the navigation buttons located on the record navigation toolbar to
quickly move between records or a group of records on a grouped data
access page.

First record
Previous record
Record source and number
Next record
Last record
Note If you don't see the record navigation toolbar on your page, it
means one of the following:
All the records are displayed on the page, so the navigation buttons are
not necessary.
The designer of the page has customized the toolbar. Look for custom
instructions on how to use the page, or contact the designer.

Add, change, or delete the path to a picture
Note The picture is not stored in the database. Rather, the path to the
picture's location is stored in the database, and the picture is stored in a
computer's file system.
1. Click inside the path field.
2. Do one of the following:
To add the path to the picture, type the path of the picture's
location.
To change the path to the picture, edit the path.
To delete the path to the picture, select the contents of the field
and press DELETE.
Notes
You cannot edit a field on a page unless the page supports edits.
The path can be a relative path, a path on your computer, a universal
naming convention (UNC) path, or a uniform resource locator (URL). The
type of path you should use depends on the requirements of the
database.
If you want to delete the picture file, you must do so from its location in
your computer's file system. See Microsoft Windows Help for more
information about deleting files.

Delete a record
Important Once you delete a record, you cannot undo the deletion from
the database.
On the record navigation toolbar, click Delete

.

Note If you don't see the Delete button, it means one of the following:
The page does not support deletions.
The designer of the page has customized the button. Look for custom
instructions on how to use the page, or contact the designer.

Preview a data access page
To preview a data access page, you must have Microsoft Internet
Explorer 5.5 or later on your computer.
On the File menu, click Print Preview.

Print a data access page
When you print a data access page, the printout contains only what is
currently displayed on the screen, including expand indicators and record
navigation toolbars.
1. Scroll to the part of the data access page you want to print.
2. Expand or collapse any groups you do or do not want to print.
3. In Microsoft Internet Explorer, on the File menu, click Print.
Note Your data access page may have a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component, which have
their own methods of selection. To display help for a PivotTable list,
spreadsheet, or chart, click Help
on its toolbar.
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Troubleshoot data access pages
Record navigation toolbar
Entering or editing data
Viewing data
Note The data access page might contain a Microsoft Office PivotTable
Component, Spreadsheet Component, or Chart Component, which has
its own troubleshooting information. To display help for a PivotTable list,
spreadsheet, or chart, click Help
on its toolbar.

